
Adobe® PHOToSHOP® CS3

Classroom in a Book®  INSTRUCTOR NOTES



Adobe Photoshop CS3 Classroom in a Book

Introduction
The Adobe® Photoshop® CS3 3 Classroom in a Book™ 
course presents students with tips, techniques, and 
solutions for using the Adobe Photoshop CS3 software.
The Instructor Notes are intended to complement the 
information in the Adobe Photoshop CS3 Classroom in 
a Book®. 

The information is organized to follow the sequence of 
instruction in each lesson. 

About the workbooks
It is recommended that each student in the class have 
an individual copy of the Adobe Photoshop CS3 Class-
room in a Book. Students will use this book as you lead 
them through projects. Additionally, the book can be 
used asa self-paced tutorial.

The Classroom in a CD package includes a PDF 
(PortableDocument Format) version of the student 
workbook. Your license permits you to print an un-
limited number of copies of this workbook. The PDF 
file is password-protected. Look for the password on 
the sleeve ofthe Classroom in a CD package or in the 
Instructor Files CD Read Me.You can buy more copies 
of the Adobe Photoshop CS3Classroom in a Book for 
your students, or you can refer them to a local book-
seller to purchase the book. 

Foradditional information, call Pearson Education at 
800-922-0579.

Course strategy
If you’re teaching a 15-session class, you can teach 
approximately one chapter of this book per class. The 
book contains 14 lessons, some of which may take a 
while to complete. If you are teaching a 10-session 
class, you may want to combine some of the lessons in 
a single class. For example:

• Lessons 1 and 13 are both focused on learning about 
the Photoshop user interface (including Adobe Bridge). 
However, because Lesson 13 also covers features in 
Photoshop CS3 Extended, it may be better suited for 
advanced users.

• Lessons 3 and 7 cover related aspects of 
photo retouching.

• Lessons 4 and 6 both are about making selections.
Also, Lessons 6 and 11 cover effects that are based on-
masking and selections.

• Lessons 5 and 10 deal specifically with layers, although 
layering is a crucial element in almost every lesson following 
Lesson 5.

• Lessons 9 and 10 both cover vector graphics. If your 
students are already competent in the use of drawing 
programs such as Adobe Illustrator, they may be able 
to skip straight to the project with the Saucer.psd file 
inLesson 9.

• Lesson 14 addresses printing issues and topics related 
to color management; after basic photo correction,  
Lesson 2 touched on four-color printing.

The following lessons cover enhanced or new 
features in Photoshop CS3:
• Lesson 1 covers the new interface, streamlined across 
the Adobe Creative Suite 3 products, and illustrates the 
updated toolbox.

• Lesson 7 details enhancements to the Adobe Camera 
Raw 4 file format and Vanishing Point filter. It in-
troduces students to Adobe Lightroom™, a new CS3 
component that incorporates raw conversion into a 
single workflow, and allows scrolling through dozens of 
images quickly, and branding and show casing them. It 
also includes valuable tips on setting up a proper work-
flow.  covers the Quick Selection tool and the enhanced 
Refine Edges feature.

• Lesson 10 covers the new Auto Align Layer feature for 
aligning two similar, but offset layers.

• Lesson 11 introduces Smart Filters, for applying non-
destructive filter effects to images.  



• Lesson 12 features the Zoomify command for tiling 
and panning large files in a web browser, as well as the 
Clone Source palette feature for cloning selections from 
a second image. 

• Lesson 13 covers enhancements to Adobe Bridge and 
features in Photoshop CS3 Extended—a version of 
Photoshop with additional functionality for the 
professional, scientific, and technical communities.  

We recommend that, at an absolute minimum, you 
teach Lessons 1 through 5. The majority of the most 
basic Adobe Photoshop features and the Photoshop 
work environment are covered in these lessons.  How-
ever, completing all the lessons through Lesson 10 
would make a far superior introduction.Before begin-
ning a lesson, encourage students to browse through it, 
read any sidebars, and watch any movies suggested in 
the text. 

Quick Time movies are indicated by the filmstrip 
icon, and are located in the Movies folder on the 
Adobe Photoshop CS3 Classroom in a Book CD.

Managing student projects
One way to simplify file storage and retrieval in class-
room situations is to ask students to create a folder on 
their hard disks, name it [Student’s, for the student’s 
name] Lessons, and then copy each project folder into 
the main Lessons folder. Having students keep all their 
working files in their own Lessons folder makes it easy 
for you to clean up files when a class is over.

Additional resources
Instructors and users of Adobe Photoshop rely on a 
variety of resources to supplement their knowledge of 
the program. You may find the following resources use-
ful to explore. Photoshop Help The Help installed with 
Photoshop contains a complete descriptions of all fea-
tures, including topics not covered in the User Guide. 
It also contains links to movies that showcase new CS3 
features, and techniques for using the software.

Adobe Photoshop CS3 User Guide 
This guide, a subset of Help, contains feature descrip-
tions. It’s useful for learning about areas of the program  

that are outside the scope of the Classroom in a Book.       
Printed copies of Adobe Photoshop CS3 
documentation area vailable for purchase from
www.adobe.com/go/buy_books.  Application DVD The 
Adobe Photoshop CS3 application DVD contains the 
Adobe Technical Info folder, PDF versions of the User 
Guide and Quick Reference Card, tryout versions of 
products by Adobe and other manufacturers, and the 
Adobe Photoshop CS3 Software Development Kit for 
experienced programmers. 

Adobe CS3 Video Workshop DVD 
Included in the product box, this DVD provides 250 in-
structional movies on Photoshop CS3 and other prod-
ucts across the Adobe Creative Suite 3 lineup.  Adobe 
Web site The U.S. Adobe Web site at www.adobe.com 
contains a variety of Photoshop training and support 
resources, including the Adobe Studio Expert Center 
for Photoshop. 

Many step-by-step tutorials, galleries, and other 
resources are available at the Adobe Web site, and the 
User-to-User Forums are a great place for students 
to learn from more experienced users. Adobe Design 
Center provides hundreds of tutorials from experts and 
authors in the community, as well as thoughtful articles 
about design and technology. 

Go to:
www.adobe.com/designcenter/.Adobe Certified Expert 
(ACE) program 

This program is designed to validate an expert skill 
level of Adobe PhotoshopCS3. Careful testing of can-
didates ensures thateach ACE has demonstrated expert 
product knowledgeof the current release of Adobe 
Photoshop, resulting in increased marketability and 
an added credential. Training for the ACE program is 
available through Adobe Authorized Learning Provid-
ers (AALP) and self-study. 

For more information about this program, send an     
e-mail to certification@adobe.com or visit theAdobe 
Web site at:  http://www.adobe.com. 

Note that several resources mentioned here are available 
directly from the Help menu in Photoshop, such as online 
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Lesson 1: Getting to Know the Work Area
The first lesson presents an introduction to the
Adobe Photoshop CS3 software. Using the basic com-
mands, tools, and palettes, your students will learn
general techniques for understanding where they are,
how to get information about the image in front of
them, and how to select the tools or enter the values
needed to change the image.

Goals for this lesson
How much time you should schedule for this lesson
depends on whether all your students already
have any knowledge of Photoshop, and on their com-
puter skills in general. The overall objective for Lesson 
1 is to make them sufficiently familiar with the user 
interface that they can locate the controls they need to 
do the procedures in the rest of the lessons. In general, 
they should be able to identify:

• They should be able to find and name the key areas of
the interface, including the toolbar, palettes (in general), 
image windows, and the tool options bar.
• They should also be able to open not only the main
menus and submenus across the top of the work area
(File, Edit, and so forth) but also context menus and
palette menus. Subordinate to this goal is gaining a 
familiarity with the different means of getting informa-
tion about Photoshop.

By learning how to help themselves, they gain confi-
dence and independence. The lesson describes three
ways to do this:

• A second method is to take advantage of the tooltips 
to identify tools, buttons, and other controls.
• A third method is to use Photoshop CS3 Help. It is
important to emphasize that Help not only contains all
the information in the printed User Guide, but it also
includes many other topics that are useful even to 
novice users.

Finding tools in the work area
You may want to introduce students to the Photoshop
environment by providing a general tour of the screen.
This helps orient the students and provides a review of

the names of the elements on the screen. For example,
you may point out the title bar and remind the stu-
dents that it indicates which publication is currently 
active. Then point out the menu bar, the rulers, the 
page icons, the palettes, and the toolbox.

Students may already be used to keyboard shortcuts as 
a simple alternative to using the mouse. Photoshop and
other Adobe products are designed to allow keys to be
used simultaneously with the mouse.

A common working technique used by many 
Photoshop professionals is to keep one hand on the 
mouse, and the other hand over the keyboard to switch 
tools and modes. You may want to demonstrate how 
this method allows the mouse pointer to remain direct-
ly over the part of the image that’s being edited, since 
you’re not always having to move the pointer back and 
forth between the image and the toolbox or menus.
You don’t have to encourage students to work this way 
in the beginning. They probably won’t be ready to use 
the shortcuts until they have a good understanding of 
when they’ll want to use each tool.

Selecting and using a tool from the toolbox
It may be useful to point out that the View > Actual 
Pixels command (same as double-clicking the Zoom 
tool) displays one image pixel for each monitor pixel, 
which also means that this magnification will display 
an image at exactly the same size as it will appear in a 
Web browser. But because monitors can be set to differ-
ent resolutions, the real size of an image when viewing 
in Actual Pixels (or a Web browser) will vary depending 
on the monitor in use.

Many users are unaware that the monitor resolution 
can be changed. You may want to demonstrate this, 
showing how increasing the resolution makes more 
room for palettes and images on screen, but with the 
tradeoff of making everything smaller.

Finally, you may want to demonstrate how to see a 
single image at two magnifications simultaneously, by 
choosing View > New View and setting a different 
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magnificationfor each window. This is handy for mak-
ing detailed changes while zoomed in, while also 
viewing the full image in another window to see the 
changes in context.

• Scrolling an image  using the Zoom tool. You can also 
scroll using the keyboard. In addition to scrolling up 
and down using the Page Up and Page Down keys, 
respectively, the Home and End keys scroll to the 
top left and bottom right corners, respectively, and 
Shift+Page Up and Shift+Page Down scroll left and 
right, respectively.

Photoshop is one of those rare programs that lets you
scroll and zoom while you are in most dialog boxes. 
This feature is very helpful when applying filters or 
other adjustments from a dialog box. You can demon-
strate this now, or just keep this in mind when teach-
ing lessons about dialog-box based filters, effects, and 
corrections.

• Using the Info bar. Some of the status bar options are 
useful in certain situations.

You might demonstrate how clicking the black
arrow opens the pop-up menu, and then discuss the 
following three options on that menu:

• The Current Tool option is useful to display when the
toolbox is hidden.
• The Efficiency option can help gauge whether or not
you have enough RAM to run Photoshop efficiently,
when working with images that are typical for you.
Anything less than 100% indicates that you may need
more RAM (or on Mac OS Classic, you may simply 
need to assign more RAM to Photoshop).
• The Document Profile option is useful when you’re
working in a color-managed workflow, because you’ll
know exactly what color profile each image uses.

Using the tool options bar and other palettes
Students should understand that the tool options bar is
not the same as the toolbar (or button bar) found in
products such as Microsoft Office. In Photoshop, the
controls that appear on the tool options bar change
depending on the selected tool, whereas controls on a
(Microsoft Office) toolbar do not. Similarly, the tool

options bar cannot be customized because it always 
represents options for the current tool. Take care to 
refer to the tool options bar by its complete name and 
not as a “toolbar” or “button bar” yourself.

Using palettes and palette menus
You may want to point out the two reasons why the Tab
keyboard shortcut is so useful. Hiding and showing all
palettes instantly allows quick evaluation of images
without the distraction of palettes, and when working
on a small screen it more easily allows use of the entire
screen for image editing.

Also show students how easy it is to collapse palettes 
to icons, and then expand the palettes again with a 
click. In this lesson, students will look at customizing a 
workspace. And  in Lesson 12, they will define a custom 
workspace in Photoshop that shows and hides specific 
palettes, based on the type of task they are performing.
You do not need to go into this feature in-depth now, 
to avoid the risk of information overload in the first 
lesson.

Using a context menu
Demonstrate how context menus change depending on
the content under the pointer. Right-click (Windows) or 
Control-click (Mac OS) over the following examples:
• Different layers
• A selection
• Text with an insertion point
• In any list palette
If your students use graphics tablets, encourage them 
toprogram their stylus button to display context menus.

Using Photoshop Help
Students may not be aware that the online Help for 
Photoshop and other Adobe products include information 
not available in the printed User Guide, such as detailed 
descriptions of filters and important guidelines for using 
them. It’s fast to search for a term in the online Help, 
and many topics include links to movies that 
demonstrate the feature. 

Using Adobe online services
Students may inquire about privacy concerns related to
the Adobe Online service. You can reassure them that 
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no personal or configuration-related information is sent 
from their computer, except that which is explicitly
typed in by the user as part of the voluntary online regis-
tration process.

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 What do you do if you can’t find a tool that you know 
exists?
2 How can you find out the keyboard shortcut for a 
tool without opening the User Guide or Photoshop Help?
3 How can you instantly hide or show all palettes?
4 What’s the quickest way to type in a specific zoom 
percentage?
5 What magnification is the best representation of an
image’s size on a Web page?
6 What do you do if you can’t find a palette that you
know exists?
7 What is the difference between a palette and an image
window?

Review answers
1 The tool you want may be hidden in a pop-up list.
Look in the toolbox for a related tool with a small black
triangle. That triangle symbol indicates that holding
down the mouse button on that tool opens a list of
hidden tools at that location.
2 Hold the pointer over the tool until the tooltip
appears containing the keyboard shortcut for that tool.
3 Press the Tab key (when you’re not editing text).
4 Type it into the Navigator palette.
5 Actual Pixels.
6 Choose the Window menu and look for the palette
name. If the palette is already open and in front of the
other palettes in its palette group, a checkmark appears
in front of the palette name on the Window menu. If 
you don’t see a checkmark, click the palette name. The 
palette will open in the front of its palette group.
7 A palette contains a set of related controls that you
select and use to work on your file. You can have many
palettes open, group them, hide them, and separate
them, among other things. The image window displays
the image file. You can have multiple image windows
open simultaneously, displaying different image files.
If you close an image window, you close that file.
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Lesson 2: Basic Photo Corrections
Lesson 2 might be have been titled “Photoshop 101”
because it gives the students experience with the most
basic and commonly used features—the sine qua non 
of digital photo editing. Even rank beginners are eager 
to learn such practicalities as how to straighten images 
that have been scanned in at a crooked angle, crop 
them, and fix the colors to compensate for a problem 
with the exposure. Lesson 2 also introduces two impor-
tant concepts: resolution issues and adjustment layers.
In addition to the lessons in this book, encourage 
students to do additional study about scanning, tonal 
correction, and color correction. This chapter merely
scratches the surface of image correction—a skill set 
that is very deep, extremely valuable, and involves con-
cepts well beyond the scope of both this book and the 
Photoshop documentation. Many books on correction 
and retouching are available from Peachpit Press.

Scheduling this lesson
Lesson 2 and Lesson 7 contain closely related subject
matter. In Lesson 2, students use the Dodge and Sponge
tools to make color changes to a limited area of the
image. Lesson 7 is entirely devoted to making similar
kinds of changes, but using different tools.

If your class sessions are long enough, you could group
these two lessons into a single session. If you do so, the
students will have to cope with a few very simple but 
less familiar techniques, such as making a selection 
(covered in depth in Lesson 4) and working in an image 
with two layers (covered in Lesson 5). However, the use 
of these techniques in Lesson 7 is so elementary that it 
should not present a serious problem.

Organizing an efficient sequence of tasks
The steps listed here are the most efficient sequence of
retouching steps, so they should usually be done in the
order presented. For example, tone correction should 
be done before color correction because correcting 
tones can have the side effect of correcting a color cast, 
reducing the amount of color adjustment needed.

Adjusting your process for intended uses
Students should be clear on the concept that the specific 

settings applied at many of these stages will differ
depending on the final output. For example, the best
resolution and sharpening values for print and web are
much different. In addition, settings that are best for 
one medium are often detrimental in another. If a 
student knows that an image will be used in more than 
one medium, the student should maintain a full-
resolution master image, and from it, derive versions 
of the image that are optimized for print, web, or other 
uses.

Resolution and image size
The topic introduces the issue of resolution, which is a
concept that students will grapple with many times in
the future. At this point, dealing with this issue may 
seem less rewarding to your students than changing the 
tulips from muddy maroon to clear red, for example, or
other tasks that have more sizzle and pop to them. You
may need to emphasize resolution in your class discus-
sions so that students start thinking about it.

Supplementing the resolution topics
One way to get students to think about resolution is to 
demonstrate opening two images at two different reso-
lutions, cutting and pasting a selection from one to the 
other, and pointing out the mismatch.  Another way 
to focus students’ attention on resolution is to discuss 
its implications. For example, you might ask students 
to describe the issues and tradeoffs involved in some 
scenarios, such as the following:

• What’s wrong with adjusting the image resolution
after you correct and retouch it?
• What’s the problem with just leaving an image at
maximum resolution?
• Somebody sends you a family photograph in email
that takes a long time to download. When you open the
image in your browser, you can see only one small area
of the picture so that you have to scroll to get an idea of
the whole shot. What should the sender have done to
avoid these annoyances?
• What’s so terrible about making the file as efficient as
possible and then scaling it up to the size you want?
• How do you increase resolution? Or can you?

LESSON 2
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Straightening and cropping an image
Students may want to know how to crop without lock-
ing proportions. To do that, simply delete the dimen-
sions in the tool options bar.

Manually adjusting the tonal range
Beginners will often adjust tones by going straight to 
the Image > Adjustments > Brightness/Contrast com-
mands, probably because the command names sound
like familiar TV controls. However, it’s best to discour-
age use of Brightness/Contrast for most situations.

The Levels and Curves commands can make an image
lighter or darker while preserving the lightest highlights
and darkest shadows. Because of the way Brightness/
Contrast works, it’s far more likely to delete useful ton-
al information, especially in highlights and shadows.
Students may ask what the Brightness/Contrast com-
mand is for. Because it performs linear changes on an
image’s tones, it can be very useful when working with
nonimage channels such as masks. But it isn’t very 
useful when handling photographic images. In other 
words, beginners are not likely to need to use the 
Brightness/Contrast command.

Removing a color cast
A 24-bit monitor is needed to see a color cast. For best
results, that monitor should also be calibrated; oth-
erwise it may not be clear whether the cast is in the 
monitor or in the image.

For students with earlier versions of Photoshop, you 
can discuss with them how the Auto Color feature 
makes it unnecessary to create an adjustment layer and 
tinker with the Color Balance by hand. It is still pos-
sible to use those techniques in Photoshop CS3, but it’s 
not necessary unless the situation is special or you are 
trying to create unusual effects.

Replacing colors in an image
Be sure students understand that they should complete
general tone and color corrections before they perform
specific color corrections such as the Replace Color
command or using the Color Replacement tool.

Adjusting lightness with the Dodge tool

When using the Dodge, Burn, or Sponge tools, the key
to believable results is subtlety. Suggest to your students
that they use these tools at low Pressure/Exposure set-
tings and build up their effects gradually.

Adjusting saturation with the Sponge tool
Caution students about saturating a color past the 
point that the output medium can handle. This can 
easily happen on print jobs, since most colors will 
exceed the CMYK gamut long before they appear over-
saturated on a monitor. You can show students how to 
watch out for over-saturation by using the Proof Colors 
and Gamut Warning commands on the View menu.

Applying the Unsharp Mask filter
You might suggest that the Threshold value should be
increased for surfaces that would become too grainy if
sharpened at a Threshold value of 0. For example, it’s
common to set the Threshold to a value of 8 or higher
for skin areas.

Saving the image for four-color printing
You might make the following points about converting
to CMYK:

• The way Photoshop converts to CMYK depends on 
theCMYK Working Space set in Edit > Color Settings. 
For example, if the Settings chosen at the top of the 
Color Settings dialog box are U.S. Prepress Defaults, the
CMYK Working Space is U.S. Web Coated (SWOP).
When working on a job for press, students should al-
ways confirm with their printer which CMYK working 
space is the best match with the printer’s equipment.
• The appearance of an image after converting to 
CMYK is often disappointing. Overall saturation is 
usually lower and some colors may shift. Reassure 
students that Photoshop is simply being honest about 
what colors can actually be achieved in the CMYK 
gamut (assuming that all Color Settings are set cor-
rectly).
• The Byte Order setting in the TIFF Options dialog 
box isn’t usually critical because most professional 
graphics programs (such as Adobe products) read both 
Mac and IBM PC byte orders.

LESSON 2LESSON 2LESSON 2



�
Adobe Photoshop CS3 Classroom in a Book

Supplementing the lesson 
You may want to demonstrate the difference between
using the Levels command and using a Levels ad-
justment layer (a concept not introduced until later 
lessons, so you’ll want to assess the readiness of your 
class to absorb this added information). If you decide 
that your students can handle this already, start your 
demonstration with two copies of the same image. On 
the first image, use the Levels command to apply three 
dramatic changes, clicking OK after each change. Do 
the same thing with the second image, but using the 
Levels adjustment layer. Then compare the histograms 
of the two images. The histogram of the image edited 
with the adjustment layer should show that far more 
tonal levels were preserved. Before converting the final, 
corrected RGB image to CMYK, tell your students to 
choose File > Save As, and save a copy of their work 
using a different filename.
Later, you can have them use this saved file as the basis
of a supplementary exercise for Lesson 7; see “On your 
own: Painting with the art history brush” of these 
Instructor Notes.

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 In the Replace Color dialog box, how do you select 
the color to be replaced? 
2 How can you lighten a small area of an image?
3 What is a color cast, and what’s the fastest, surest way
to remove it from an image?
4 Why do some images need to be converted to CMYK?

Review answers
1 Click the eyedropper on the color you want to 
change.
2 Use the Dodge tool.
3 A color cast is an imbalance in the color of an 
image, which might be caused by anything from 
problems with the camera exposure settings to the 
deterioration of the original photograph scanned in 
to create the image file. The simplest way to remove 
the color cast is to choose Image > Adjustments > 
Auto Color. The Auto Color command automatically 
reads and corrects the color balance in the image.
4 An image must be converted to CMYK to be able to
print properly on a CMYK printing press.
             

LESSON 2



10
Adobe Photoshop CS3 Classroom in a Book

This lesson is a logical follow-on to Lesson 2, in that it
teaches students how to continue their correction of
images—this time, by addressing image flaws. Retouch-
ing is so basic an image editing task that Photoshop 
incorporates a sequence of menu commands for it in 
the Help menu (How To Fix And Enhance Photos).

Where correction follows a logical order, retouching is 
more subjective. But like many art projects, it can be 
overdone. Help students learn how to look closely at 
before images, to see what needs correcting, and at the 
results, to make sure that the image has been improved 
enough—but not so much that it no longer looks
realistic.

Like correction, repairing images is a vast subject 
touched on only briefly here, that involves concepts
well beyond the scope of both this book and the Photo-
shopdocumentation. Many books on correction and
retouching are available from Peachpit Press.

This lesson also introduces students to the History
palette, a valuable tool in undoing and stepping back-
wards in their work. You may want to have students 
practice zooming in closely on an image, to spot transi-
tional areas of color, as well as similar-colored selec-
tions, which can be made up of many colors. 

Goals for this lesson
At the end of this session, your students should be able
to describe the strengths and limitations of the various
retouching strategies, and know which tools to use for 
specific repairs. 

Repairing areas with the Clone Stamp tool
Encourage students to work in short strokes with the
smallest brush size that makes sense. If the brush size is
too large or the strokes are too long, areas of the image
will start to visibly repeat, and the image will no longer
look natural. You may want to suggest that students 
bring in their own images to work on and use as they 
experiment with these new tools. 

Taking a snapshot
Point out that when you use the History palette in this
way, it is no longer being used as a simple list of undo
steps. Instead, the past is being used as a resource for
painting. It can enable you combine two versions of an
image into a single image that represents the best of 
both worlds. Make sure students understand that his-
tory states aren’t saved with the document. You can 
suggest that if students want to keep different versions 
across sessions,they should set up an image’s states as 
separate layers or documents instead.

To supplement the information in this section of the
book, you can tell students about the New Document
command in the History palette menu. This is even
faster than using the Save As command or other multi-
step methods of creating new documents. Point out 
that they can use this feature by selecting any available 
history state or snapshot and then choosing the New 
Document command. Then, they can go forward to the 
latest History palette step of the original document and
continue working, secure in the knowledge that they 
can always go back to the new file they created if they 
want to start over at that point.

Note: The New Document command is also available 
in the context menu when you right-click (Windows) 
or Control-click (Mac OS) a history state. 

Retouching on a separate layer
You may want to have students practice retouching
portraits to match skin tones as accurately as possible. 
Refer to the techniques and tips in Lesson 1 for zoom-
ing in and out of an image.

Using the Healing Brush on a duplicate layer
In these projects, students will always leave the Sam-
pled option selected as the Source (in the tool op-
tions bar). However, you might ask them to speculate 
about the Pattern option. Then you can invite them to 
experiment with that option, selecting a pattern in the 
Pattern popup, and applying the pattern to an image 
with the Healing Brush tool or Patch tool. This applies 

Lesson 3: Retouching and Repairing 
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the pattern according to the properties of the selected 
retouching tool. Be sure to tell your students to discard 
their experimental changes before continuing with the 
lesson.

Supplemental information: Comparing the 
retouching tools 
Usually, students have little trouble understanding how
the Clone Stamp tool and Pattern Stamp tool work 
after they get some hands-on experience with these 
tools. However, even after students become competent 
in using the Healing Brush tool or Patch tool, they may
have difficult explaining how the tool does what it does.
If this lack of understanding makes some of your 
students uneasy, you might explain to them that the 
Healing Brush and Patch tools have to do with reading 
the texture and color information separately. Thus, 
Photoshop collects texture information about the area 
selected to be the resource for the retouching (such as 
theunblemished areas around the rock climber or the
unwrinkled areas of the chef ’s face) and combines it
with information about color it collects from the area
designated to be retouched to create unique results.
If the students don’t care why the tools work, there’s 
no need to require them to understand or explain it. As 
long as they can use the tools comfortably, that’s fine.

Supplemental information: Best practices
You may want to encourage students to think about 
these issues before they begin making adjustments. 
They should:

• Work with a monitor that’s calibrated and profiled. 
For critical image editing, this is absolutely essential. 
Otherwise, the image on the monitor will look different 
when printed.
• Be judicious in correcting images. Any color or tonal 
adjustment to an image discards some image informa-
tion.
• For critical work and maximum preservation of im-
age data, it’s best to work with images with 16 bits per 
channel (16_bit image) rather than 8 bits per channel 
(8_bit image). Data is discarded in making tonal and 
color adjustments. The loss of image information is 
more critical in an 8_bit image than a 16_bit image. 
Generally, 16_bit images have a larger file size than 
8_bit images.

• Work on a copy of the image file, not the original. 
• Remove any flaws such as dust spots, blemishes, and 
scratches from the image before making color and 
tonal adjustments.
• Use adjustment layers to adjust the tonal range and 
color balance of an image rather than applying an ad-
justment directly to the image layer itself. Adjustment 
layers allow going back and making successive tonal 
adjustments without discarding data from the image 
layer. Keep in mind that using adjustment layers adds 
to the file size of the image and demands more RAM 
from your computer.
• Consider using tools like the Info or Histogram pal-
ette in Expanded view, to provide invaluable feedback 
on adjustments.
• Make a selection or use a mask (Lesson 6) to confine 
color and tonal adjustments to part of an image. Or 
set up a document with image components on differ-
ent layers (Lesson 10). Color and tonal adjustments are 
applied to only one layer at a time and affect only the 
image components on the targeted layer.

Review questions
The following questions are not in the student’s 
Classroom in a Book.
  
1. How do you sample a selection with the repair tools? 
The Clone Stamp or Healing Brush tool allow sampling 
sources in the current document or any open docu-
ment in Photoshop. To set the sampling point, select 
the Clone Stamp tool and Alt-click (Windows) or 
Option-click (Mac OS) in any open document win-
dow. You can set up to five different sampling sources 
at a time in the Clone Source palette. To set another 
sampling point, click a different Clone Source button  
in the Clone Source palette.
 (In Photoshop Extended, you can clone video or 
animation and set sampling points in the current frame 
you’re painting or sample sources in a different frame, 
even if the frame is in a different video layer or in a 
different open document. To clone video or animation 
frames, use the Animation palette, select the timeline 
animation option and move the current-time indicator 
to the frame with the source you want to sample.)
2 What’s the difference between the Healing Brush tool 
and the Spot Healing Brush tool?
3 Does it matter whether repairs are done in RGB or 
CMYK mode?
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Review answers
1 Click the eyedropper on the color you want to 
change.
2 The Spot Healing Brush works similarly to the Heal-
ing Brush: it paints with sampled pixels from an image 
or pattern and matches the texture, lighting, transpar-
ency, and shading of the sampled pixels to the pixels 
being healed. Unlike the Healing Brush, the Spot Heal-
ing Brush doesn’t require you to specify a sample spot. 
The Spot Healing Brush automatically samples from 
around the retouched area..
3 RGB mode has a larger color gamut than CMYK, so 
editing in RGB color mode allows preserving more 
colors. However, you should edit an image in its final 
color mode. That is, if the image will be printed, work 
in CMYK mode. If the image will be used online, edit 
in RGB mode. If the image will be repurposed—for 
example, posted online and then printed—work in the 
larger gamut RGB mode.
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Lesson 4: Working with Selections
Selecting is a critical skill necessary for precise control
over corrections and effects. This lesson introduces 
students to a more in-depth understanding of selection
tools, options, and techniques. Emphasize to your 
students the importance of mastering selection skills. 
Students can avoid a great deal of editing rework and 
produce higher-quality results just by knowing the best 
way to select an area and how to adjust and fine-tune a 
selection.

Goals for this lesson
At the end of this session, your students should be able
to describe the strengths and limitations of the various
selection tools, to demonstrate how to transform a se-
lection, and to accurately distinguish between the pixels
within a selection and the selection itself. 

The techniques for selecting are fairly easy in them-
selves.However, the concepts of selecting, selection bor-
ders, and selected areas leads to more complicated ideas
and processes, such as masking, alpha channels, and so
forth. It is imperative that your students be completely
comfortable with their mastery of selection procedures
before they move on to more advanced lessons. The 
next level of advancement for this topic comes in
Lesson 6, when students work with masks.

About selecting and seletion tools 
The Single Row Marquee and Single Column Marquee
tools are useful for correcting special cases, such as 
wiping out film scratches and scanner artifacts.

Selecting with the Magic Wand tool
For a complete understanding of the magic wand, have
the students observe how the selection changes when
they:

• Change the Tolerance value in the options bar.
• Leave the Tolerance value unchanged, but click pixels
of different values

Moving a selected area
You may want to ensure that your students understand
the difference between moving a selection and moving

pixels, because it’s easy for beginners to confuse the two.
Several transformation commands appear in the 
menus, but they all require you to think ahead. Suggest
to the students that in most cases they might want to 
try the Free Transform command first, for several rea-
sons. It can perform any transformation (so you don’t
have to think about which command to choose), and it
can transform interactively, which means it’s the most
fun and intuitive way to transform. 

The other transformation commands are most use-
ful when a precise transformation is required, such as 
an exact horizontal flip. Be alert for potential confu-
sion about the transformation command in the Select 
menu: Transform Selection, should your students 
discover it. 

The difference between this command and the trans-
formation commands on the Edit menu is that the 
Edit commands transform the pixels in the selection. 
In contrast, Transform Selection (in the Select menu) 
is the command to choose when you want to trans-
form the selection border without altering the pixels. 
You may want to demonstrate this difference. They 
both come in handy, but using the wrong one can be 
frustrating.

You might emphasize the importance of deselecting. In
Photoshop, you can’t deselect an area just by clicking a
spot outside the selection or by selecting a different 
tool, as you can do in many other applications, from 
wordprocessors to Web browsers.

This may seem to your students like a disadvantage at
first—because it seems to add an extra step. You might
explain its benefits are central to the advanced uses of
Photoshop. The advantage of making a selection is that
you can then apply a change to the selected area, often 
by using another tool. How ridiculously counter-
productive would it be if selecting a new tool caused 
the area to be deselected?

You might remind your class that the “extra step” is also
a safeguard. Intricate selections can time-consuming.
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Because you must actively deselect, you cannot 
accidentally deselect something that you have 
painstakingly selected.

Using the Magic Wand with selection tools
This is a good section in which to point out the flex-
ibility of Photoshop when making selections. Some 
students may find selecting to be a tedious and stressful
operation if they feel they have to get it absolutely right
the first time. If you observe this, reassure the students
by telling them that it isn’t necessary to achieve a per-
fect selection right away. Point out that as Photoshop 
users become experienced, they’ll perform a selection 
in multiple passes. On the first pass, an approximate 
selection is good enough. On subsequent passes it’s 
simply a matter of using any combination of selection 
tools and techniques (such as the ones in this topic) to 
fine-tune a selection until it’s perfect.

Moving and duplicating simultaneously
You might brainstorm with your students about other
uses of this technique in combination with using the 
Shift key to constrain movement, such as when creating 
web buttons or other repeating patterns.

Cropping an image and erasing within a
selection
You may want to point out how the Crop tool can be
customized in the tool options bar for precise crops.

Quick Selection
New in CS3, the Quick Selection tool makes quick, ac-
curate selection of an irregularly shaped object without 
having to manually trace the object’s edges. You may 
want to suggest students try using the tool to paint oth-
er selections, and then apply the Photoshop automatic 
edge enhancement for greater selection accuracy.

Refine Edges
Encourage students to try out other Refine Edges 
option with a selection, to see the usefulness of differ-
ent matte colors and backgrounds. 

Isolating and saving selections
Point out to students that it’s a good work habit to re-
name selections meaningfully. It helps them easily find 
their work, and keep their work organized. 

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 Which selection tools can draw straight lines?
2 What’s the fastest way to make a semi-circular
selection?
3 How do you move a selection with the keyboard?
4 If you make a selection and you missed an area, 
what’s the fastest way to correct it?
5 How do you switch from the Magic Wand tool to the
Magic Wand Plus tool or the Magic Wand Minus tool?

Review answers
1 The Polygon Lasso tool, or the Lasso tool when you
hold down Alt/Option.
2 With the Elliptical Marquee tool, hold down Shift 
and draw a circle. Then with the Rectangular Marquee 
tool, hold down Alt/Option and draw a rectangle over 
half of the circle to subtract it from the original circular 
selection.
3 Nudge a selection by pressing the arrow keys.
4 Just press Shift and use any selection tool to add the
missing area.
5 You must use keyboard shortcuts to select these tools
because there is no pop-out list on the toolbox for the
Magic Wand tool. To add to a selection with the Magic
Wand Plus tool, hold down Shift and click the Magic
Wand tool on the area you want to add. To subtract, 
hold sdown Alt (Windows) or Option (Mac OS) and 
click.
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Lesson 5: Layer Basics
Layering is one of the key features of Photoshop. Using
layers, students can take full advantage of the digital
nature of Photoshop to create complex images with
sophisticated visual richness.

Beginners often see Photoshop as a simple digital ver-
sion of a painting canvas or photograph, but this view
does not do justice to the potential of the Photoshop
application or the opportunities it provides the user.

Goals and objectives for this lesson 
Your goal in this lesson is to move your students from
treating the screen as a single sheet (either blank or 
containing an image) to thinking of it in terms of a 
structureddocument with parts (layers) that can be ed-
ited independently. Successful students will understand 
that thinking in terms of layers gives them the flexibil-
ity to change their mind at any time, adapt work at the 
last minute to incorporate client-requested changes, 
leverage files to create alternate versions of an image 
within the same file, and to do other things that would 
be a great deal more trouble on a real paint canvas or in 
a darkroom. 

As subordinate objectives for this lesson, aim to make 
students able to correctly explain the following con-
cepts and to describe their importance or relationships 
to other aspects of the lesson:

• Basic types of layers: background, image, text
• Transparency (transparent pixels)
• Opacity (semi-transparency of pixels)
• Stacking orders of layers
• Layer sets
• Visible layers and hidden layers
• Active (selected) layers and inactive layers

Getting Started
Now that the students have completed a few les-
sons, many of them probably feel confident enough 
to start up Photoshop without even reading the 
“Getting Started” topic. This might be a good time 
to reinforce the idea of restoring default prefer-
ences at the beginning of each lesson.

Renaming a layer and copying a layer
Here is one of the key benefits of layers. By keeping the
photo, shell, letter, and paper texture images each on its 
own layer, they can be reused in other documents very 
easily and never have to be tediously extracted from a 
busy background.

Selecting and removing some pixels from a layer
One common stumbling block for the novice Photoshop 
user is forgetting that a layer must be active
(selected) in order to be changed.

Sometimes students who are used to working in ap-
plications such as Adobe Illustrator or Adobe InDesign 
think that they can just click an item they know is on a 
separate layer to make that layer active. For example a 
student might assume the clicking the shell or the paper 
texture backgroundof the lesson image file might switch 
the active layer to the one containing that subject matter. 

The good news is that because a selection border is inde-
pendent of the pixels shown inside it, users can apply a 
selection to another layer just by clicking the layer name 
in the Layers palette.

Related exercises or demonstrations 
If appropriate, you can demonstrate the importance 
of knowing which layer is active or have the students 
experiment with this. For example, try making changes 
on a layer of a multilayer image and then using the layer 
visibility icons to view the changes.

One easy and dramatic way to do this is to make a dupli-
cate layer of a single-layer image file by dragging the
original layer onto the New Layer icon at the bottom of
the Layers palette. Then, in the Layers palette, select the
lower layer so that it is the active layer. Select any color
from the Swatches palette and then use the Paintbrush
tool and drag it around the image. Because the active
(lower) layer is hidden behind the duplicate layer, the
display in the image window appears unchanged. How-
ever, when you click the eye icon for the upper layer to
hide it, the paint strokes you made early are now
revealed on the lower layer.
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You can set up another demonstration by selecting half
an image and choosing Layer > New > Layer via Cut so
that you have half the original image on one layer and
half on another. Then create a selection border that
overlaps the boundary between the two halves. When
you make changes (such as to move, transform paint,
burn, or dodge) to or within the selection, ask your 
students to explain why you get the results you do.

Changing the opacity and the mode of a layer
If the concept of blending mode isn’t clear to the stu-
dents, you might want to explain that blending mode
determines how layers combine, while opacity deter-
mines how much layers combine.

It’s a good idea to break out the different levels of 
opacity and blending modes here. You might want to 
ensure that students understand that both opacity and 
blending mode are options not just for layers, but for 
layer effects and painting tools, too. Because of all the 
combinations, it can be confusing to determine exactly 
how to apply or edit an image. Suggest that students 
apply blending modes and opacity in the following 
sequence:

• Blending mode by layer
• Opacity by layer
• Blending mode by effect
• Opacity by effect
• Blending mode by tool
• Opacity by tool
The reasons for this suggested order are:
• Blending mode has more of a fundamental effect on
appearance, so it should be adjusted earlier.
• Opacity is a good tool for lowering the intensity of an
existing effect, so it’s good to adjust later.
• Layer blending mode/opacity and styles can be
changed at any time, so they should be adjusted first so
that you can change your mind.

Adding a gradient layer
This lesson introduces students to the use of the but-
tons or icons at the bottom of a palette. You might
remind students that these are convenient shortcuts for
commands available elsewhere in the user interface: on
menus (such as File or Edit), context menus, and pal-
ette menus. However, many of the palette buttons
include extra functionality, such as the ability of the

New Layer button to duplicate a layer that you 
drag onto it.

It’s a good idea to make sure that students understand
the difference between Foreground to Transparent and
Foreground to White. 

Applying a layer style
You may want to do a quick demonstration to point 
out the advantages of layer styles over traditional filters.

Make a copy of an image. On the first image, apply a
layer style (such as Drop Shadow), and on the second
image, apply the same effect with a traditional filter.
Show how the layer style is easily editable while the 
traditional filter is not. 

Point out that many of the long, complicated recipes 
for special effects covered in older Photoshop books are 
no longer necessary because you can now apply an in-
stant and editable layer style to achieve the same effect. 
Students should develop an attitude of looking for the 
most efficient way to do things.

Caution students that the single-key shortcuts in Pho-
toshop (such as V for Move tool, C for Crop tool) don’t
work when you’re entering text because they enter 
characters in that mode. Make sure they learn how to 
exit textediting mode so that they can safely switch to 
othertools. For example, Ctrl+Enter (Windows) or 
Command+Return (Mac OS) will apply changes and 
exit text mode, while Esc will cancel changes and exit 
text mode.

Flattening and saving files 
When preparing files for use in a page layout program,
it’s best to use flattened copies of files because they take 
up less space and are more widely compatible with 
other applications.

Students must understand that once a file is flattened,
there is no way to unflatten a file. That is as impossible
as unbaking a cake into its original ingredients. This is
why all users should archive an unflattened (layered)
original of their work, in case something needs to be
changed.  You may want to point out that there is an 
Always Maximize Compatibility For Photoshop (PSD) 
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Files preference under Edit > Preferences > 
File Handling. If this is selected, Photoshop always 
saves a flattened version with the file. However, it’s 
usually recommended that this be turned off, because it 
makes a file take up more disk space.

Using layer comps
The example given in the lesson is fairly simple, but 
you can challenge students to think of other ways that 
this would be a time-saving or practical advantage. 
There’s more use of layer comps in Lesson 10, for the 
creation of a package prototype. Again, the example 
is just a simple one, but it makes the concept easy to 
grasp, and the students should have little trouble imag-
ining other scenarios in which this would prove useful.

Supplementing the lesson
If your students are eager to learn more about layers, 
you might invite them to explore the options at the top 
of the Layers palette (the blending mode pop-up menu, 
Opacity, Fill, and Lock options).

See also  “Related exercises or demonstrations”  and 
“Applying a layer style” in these Lesson 5 Instructor 
Notes.

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 What’s the easiest way to change the appearance of a
layer?
2 How can you change the way in which layers combine
visually?
3 How can you make a layer partially transparent?
4 How can you remove pixels of a specific color range?
5 Suppose you have a selection border perfectly drawn
around an area of the image you want to work on, but
discover that the wrong layer is active. What do you do
now?
6 Give an example of how you might exploit the fact
that selection borders in Photoshop are independent of
the pixels within them?

Review answers
1 Apply a layer style, which can include any number of
effects, and is reversible at any time.
2 Apply a blending mode.
3 Change the opacity of a layer.
4 Use the Magic Eraser tool.
5 Easy—you just find the name of the layer you really
want in the Layers palette and click it to make it active.
The selection border now applies to the pixels on that
layer, so you can continue with your work.
6 Answers will vary, but one example might be for cut-
ting identical “holes” in multiple upper layers to reveal
that shape in a lower layer. Another example will be 
evident later, when they do Lesson 12: to repeat a shape 
by applying filters or other properties in another part 
of the image without reproducing the original selection 
contents. Students may suggest many ways to use the 
independent selection border, some of which we may 
not have thought of ourselves. You might make note of 
their suggestions,and then revisit this question at the 
end of Lesson 6 and ask them if they can do all these 
same things using alpha channels.
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Lesson 6: Masks and Channels
Masks are a powerful way to control both where and
how much an effect changes an image. This lesson
guides students through the various levels of the exten-
sive Photoshop masking features. Students start with 
the easy-to-use Quick Mask. Then they learn about the 
relationship between selections, masks, and channels.

This lesson builds on Lesson 4, “Working with Selec-
tions,” so make sure that your students are competent 
in that area before launching into Lesson 6. The next 
levels of advancement for this skill area will follow in 
Lessons 8, 9, and 10, which build on both Lessons 4 
and 6.

Working with masks and channels
To a beginner, the differences among selections, Quick
Mask mode, channels, and layer masks can be very con-
fusing. You might explain it in terms of the following 
key differences:

• Quick Mask mode is fundamentally a selection
marquee that’s shown in a different form. Both are
temporary because they disappear as soon as the cur-
rent selection is changed.
• An alpha channel (a channel used for selection) is
like a Quick Mask that can be saved with the docu-
ment, but it doesn’t apply to any layer until you load it 
as a selection.
• Make a distinction between alpha channels and the
channels that make up the printable image (for ex-
ample, the Red, Green, and Blue channels in an RGB 
image). You apply alpha channels to image channels.
• A layer mask is an alpha channel that’s tied to a spe-
cific layer. Layer masks aren’t covered in this lesson, but 
you’ll want to keep this distinction in mind when layer 
masks appear later in the book.

Creating a quick mask
Quick Mask mode is great for students because 
it’s much more forgiving than drawing a selection 
marquee. In Quick Mask mode, there is never any 
danger of accidentally “dropping” a carefully drawn 
selection.

Extracting the paper texture 
Caution students that they should always use the 
Extract feature on a copy of an image, because areas af-
fected by the Extract feature are not simply hidden, but 
completely removed from the file. This lesson features 
a simple extraction. Encourage students to try out the 
feature on a more complicated organic selection, such 
as images containing hair, grass, or leaves.

Students may find the Highlighter tool easier to use if
they understand that what they are doing is helping
Photoshop recognize the edges of the object that they
want to isolate.

Applying effects using a gradient mask
It’s important for students to understand that this is 
not just an exercise about using a gradient to fade an 
effect. The real point of this is that you can use shades 
of gray in a channel or mask to control the intensity of 
an effectanywhere in an image. Darker parts of a chan-
nel willapply an effect more intensely. You may want to 
demonstrate another common example of this—using 
a feathered circular mask to create a vignetting effect. 

Colorizing with an adjustment layer
In this procedure, students make a clipping group of 
the Hue/Saturation adjustment and paper texture. 
In the next procedure, “Grouping and clipping lay-
ers,” they copy this clipping. Grouped layers cannot be 
clipped; only individual layers can be. 

Supplementing this lesson
One of the concepts that might benefit from additional
emphasis is the idea of loading a selection. Although 
students rarely have difficulty following the directions 
for doing this, some of them forget how it was done 
with equal ease. 
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Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 How does painting with black, white, and gray in a
channel affect an image?
2 How does the Extract feature recognize an edge?
3 How do you apply a saved mask to an image or layer?

Review answers
1 Black areas completely protect an image from
changes. White areas are completely subject to change.
In gray areas, lighter areas are more subject to change
than darker areas.
2 Extract recognizes an edge by finding where the con-
trast is highest within the area you highlighted.
3 Choose Select > Load Selection, and then select the
mask (alpha channel) you want to use. 
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Lesson 7: Photo Retouching
The use of digital photography is growing phenome-
nally among creative professionals as well as hobbyists, 
and Photoshop has many, many features that stream-
line the handling and routine processing of digital pho-
tographs. From correcting red-eye to adjusting Camera 
Raw settings, this lesson covers a span of beginner to 
advanced digital image-editing techniques. Be prepared 
for this lesson to generate a lot of interest among your 
students.

Goals and objectives for this lesson
Your goal in this lesson is to give your students a well-
rounded understanding of how they can perform many
routine corrections to digital photographs. This lesson 
isaimed at the advanced hobbyist and/or professional
photographer who wants to use Photoshop to clean up
images captured by digital cameras. 

Most of the topics and techniques have to do with basic 
image clean up--eliminating red-eye and adjusting the 
white point and other settings of Camera Raw images, 
but it also includes some more advanced techniques, 
such as the Lens Correction and Vanishing Point filters. 
For more practice with the Vanishing Point filter, see 
Lessons 10 and 13.

Getting started
This lesson builds on the techniques that were covered
in Lessons 2 and 3, and as such, you may want to con-
sider teaching it on the heels of those lessons, and then
proceeding to Lessons 4 through 6. 

Processing camera raw files
Camera raw is a digital image file format that is fast
growing in popularity because it gives photographers
control over image data that previously was determined
by the camera. Many digital cameras support the Cam-
era Raw format, which allows photographers to adjust
white point, tonal range, contrast, and many other set-
tings directly in Photoshop. Emphasize to your students 
that Camera Raw is a flexible, powerful file format and 
that once they understand how to use the Camera Raw 
dialog box, they’ll have greater artistic control over their 

images while still being able to preserve the original raw 
files. Note that the Camera Raw dialog can be accessed 
from within Bridge or Photoshop. The same features and 
functionality are in both.
    
The filmstrip that appears on the left side of the dialog
box when students open the three mission images will
not be there when only one image is open in the dialog.
Reassure students about the yellow caution triangle that 
appears in the upper right corner of the images in
Bridge. The warning disappears after a few seconds; it’s
nothing to be alarmed about. It simply appears while the 
settings are being applied to the camera raw image files.

Reducing noise
The noise in the portrait of the mother and son might be 
difficult for some students to see. Be sure to have them 
zoom into the sky, where it is more noticeable.

Defining a grid
Defining a grid in the Vanishing Point dialog box using
the Create Plane tool is like stretching a rubber band. As the 
students start to click, they wrap the band around the side 
of the house in the image. A blue outline indicates a valid 
plane. Red indicates an invalid plane—Vanishing Point 
cannot tear off a perpendicular plane from an invalid plane. 
Students may simply press Backspace (Windows) or Delete 
(Mac OS) to delete the last node if the outline appears red. 
Or, after drawing, drag an corner node to adjust the plane. 
It will turn blue as soon as it becomes valid. To help with 
node placement, tell students to press and hold the X key to 
zoom into the preview image as they place the nodes.

Supplementing this lesson
Using other lesson Start files as a starting point (or your 
own examples), discuss with students how they would go 
about retouching and reproducing flaws, color imbalances, 
artifacts, and other anomalies in their images. You may 
want them to name the various tools they could use, and 
how, as well as other Photoshop features they would use to 
accomplish their goals. Try to develop as many scenarios, 
and get students to suggest likely correction strategies, as 
possible. 
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 Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 Why encourage students to edit photos in camera raw 
format, rather than in JPEG? 
2 What is white balance and when/how should you edit
it?
3 What is the Vanishing Point filter and when would
you use it?
4 Suppose you are assigned to create a wallpaper-like
pattern using your company logo. If you had to use one
of the tools you learned about in this lesson, which one
would you use?

Review answers
1 Students are encouraged to begin editing photos in 
camera raw format because that format stores unpro-
cessed picture data from a digital camera’s image sensor 
and doesn’t do any image processing. Thus, the file is 
like a photo negative: you can use Photoshop to set the 
white balance, tonal range, contrast, color saturation, 
and sharpening. You can also return to the file—as 
you would a negative—and change settings for other 
output. In contrast, the JPEG file format loses image 
quality each time the file is edited and saved. 
2 White balance sets the color balance of the image to
reflect the lighting conditions under which the photo
was taken. It comprises temperature, which determines
the “coolness” or “warmness” of the image, and tint,
which compensates for magenta or green color casts in
the image. It is the first setting you should adjust in the
Camera Raw dialog, which initially displays the white
balance at the time of exposure. You can choose from
predefined settings, or specify custom Temperature and
Tint values.
3 The Vanishing Point filter lets you define a perspec-
tive plane in an image so that you can then paint, clone,
and transform images according to that perspective. 
You can even create multiple planes that are related to 
one another, and paint, clone, and transform across 
these planes through an image.
4 The Clone Stamp tool would be a good bet. However,
there are more efficient ways to do this, using other
tools.
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Lesson 8: Typographic Design 
Many designers don’t realize that the typographic tools
in Photoshop are extremely robust and sophisticated.
Among the type features are support for OpenType,
extensive character and paragraph formatting capa-
bilities, and support for a wide variety of effects and 
transformations (such as positioning text on a path and 
warping text). This lesson covers an extensive array of 
type features in Photoshop.

Goals and objectives for this lesson
Students who have used Photoshop over the years may
be used to working on images in Photoshop, but 
switching to Illustrator to work on the type for their 
composition.

This lesson is designed to show them that they don’t 
need to switch applications to create great-looking type 
in image compositions. The project involves creating 
type for a mock-up of a label for a new product (a new 
brand of olive oil). If students ask why this work isn’t 
done in Illustrator, explain that the work could be done 
in that application, but the idea is for designers who 
primarily use Photoshop to learn that they can do the 
same work in the application with which they’re most 
familiar and comfortable, without switching.

Scheduling this lesson
This lesson stands on its own quite well. It doesn’t have
to be taught in lesson order, but students would do well
to first complete Lesson 5, “Layer Basics,” and Lesson 6,
“Masks and Channels,” before tackling this topic. Those
lessons provide a solid foundation for the material 
covered in this lesson.

Adding point type
Students must press Enter (Windows) or Return
(Mac OS) after entering the point size in the type
options bar to make the setting stick (step 1). Pressing
Tab or simply clicking on another option, such as the Font 
Family pop-up menu, will cause the size to revert to the 
previous value. Students may be frustrated if they don’t 
press Enter or Return and can’t get the size value to stick.  
Also, make sure your students understand and 

remember to click the Commit Any Current Edits 
button (step 2). If they don’t, they remain in text-edit 
mode. This means that the type layer name on their 
screen won’t match the name in the book, which can be 
confusing to students. Also, they might have difficulty 
continuingwith the exercise and performing other 
operations, such as applying layer effects. 

A common mistake among new Photoshop users is to 
not commit changes, and then try to enter more type 
on a new layer, but find the new type is on the same 
layer. Show them that in addition to  clicking the Com-
mit Any Current Edits button to exit text edit mode, 
students can press the Enter key on their numeric key-
pad; press Ctrl-Enter (Windows) or Command-Return 
(Mac OS); select any other tool in the toolbox (besides 
the Type tool); or click in the Layers, Channels, Paths, 
Actions, History, or Styles palette.

Making a clipping mask and 
applying a drop shadow
Students may also complain (in this exercise or others)
that pressing Shift and dragging doesn’t affect the drag
operation—that is, it doesn’t constrain movement. The
effect can be subtle. They might see it better by drag-
ging more slowly, or by dragging and then pressing 
Shift after they start, to see the difference. In any case, 
all positioning of type in this label is approximate. Text 
elements don’t have to be perfectly centered or posi-
tioned. Studentscan eyeball it.

Creating a design element from type
This lesson doesn’t explain much about the Anti-alias-
ing menu, but it’s a topic that you may want to explore 
further with your students. Anti-aliasing lets you 
produce smooth-edged type by partially filling the edge 
pixels. This causes the edges of the type to blend more
smoothly into the background. The choices are:

• None, which applies no anti-aliasing,
• Sharp, which makes type appear the most sharp,
• Crisp, which makes type appear somewhat smoother,

LESSON 8



23
Adobe Photoshop CS3 Classroom in a Book

• Strong, which makes type appear heavier, and
• Smooth, which makes type appear smoother.

Sharp is a common choice for print design, and does a
good job of reducing unwanted “jaggy” edges. If you’d
like, have your students zoom in to the type and toggle
through the various anti-aliasing settings to see the dif-
ference. Be sure to have them zoom back out to see the
effect at normal size (double click the Zoom tool to see
at 100%). 

Adding paragraph type from a sticky note
Depending on the typeface that students choose and 
the exact dimensions of their text box, they may not 
need to compensate for gaps in the second-to-last line 
of the paragraph. Conversely, they may need to finesse 
spacing elsewhere in the paragraph. This is a good op-
portunity for students to play and explore the para-
graph type controls as they desire.

OpenType in Photoshop
This sidebar requires jumping into Adobe Illustrator to
preview OpenType glyphs. Make sure that your stu-
dents’ computers are all equipped with Illustrator CS3 
(or CS2 or CS) before performing the tasks described. 
Alternatively, if you don’t have the software, simply 
play the QuickTime movie for students. The movie 
comes on the Classroom in a Book CD, in the Movies 
folder.

Warping with Smart Objects
Dragging the warp grid may be tricky for some stu-
dents. The exercise instructs students to drag guides 
onto the image window to assist them, but if they click 
the wrong handle or an off-center part of a line, the 
desired contour warp will easily be distorted or difficult 
to achieve. Tell students not to worry. They can use 
Control/Command-Z to undo a drag, and their warp 
doesn’t have to be completely accurate or perfect.

Supplementing the lesson
If you have a copy of Adobe Illustrator CS3 (or CS2 or 
CS) available, which is necessary to complete the Extra 
Credit at the end of this lesson, consider demonstrat-
ing for students how Illustrator creates type compared 
with how Photoshop does. Point out some of the type 
controls in Illustrator, such as the OpenType submenu 

and Glyphs palette. Photoshop now features robust 
typographical capabilities that make it easy for students 
to create impressive type. If you can, bring in examples 
of well-set type, compared with orginary type. Discuss 
with students typographical features that make type 
appear finished—for example, adjustments to tracking, 
leading, kerning, and baseline shift.  

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 What is the function of the Commit Any Current 
Edits button?
2 How do you create vertical type in Photoshop?
3 What is OpenType and how is OpenType supported 
in Photoshop?
4 What is a true fraction and how do you create it?
5 What is a glyph?

Review answers
1 Clicking the Commit Any Current Edits button takes
you out of text-edit mode so that you can perform such
operations as applying layer effects and styles.
2 Select the Vertical Type tool, hidden under the 
Horizontal type tool, and click and type in an image 
window.
3 OpenType is a cross-platform font file format de-
veloped jointly by Adobe and Microsoft. It supports 
widely expanded character sets and layout features, 
such as swashes, ligatures, and fractions. You can access 
Open-Type features and characters by choosing Open-
Type from the Character palette’s pop-up menu, and 
thenchoosing from the available options.
4 A true fraction displays the numerator as a super-
script, the denominator as subscript and replaces the 
slash with a fraction bar. PostScript and TrueType fonts 
have true fractions in their character set: ¼, ½and ¾. 
You can also make custom fractions using a OpenType 
font. Simply type fractions as usual—for example, 1-
slash-2—and then select the characters, and from the 
Character palette menu, choose OpenType > Fractions. 
Photoshop applies the true fraction.
5 A glyph is a specific form of a character, such as an 
upper- or lowercase letter. 
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Lesson 9: Vector Drawing Techniques
This lesson introduces students to vector paths
as a way to create smooth lines and as an alternative
method of selection. Students will learn how to use 
vector paths to create complete drawings and to control 
transparency. 

Students will also be introduced to easy ways to create 
vector shapes, such as with shape tools and custom 
shapes. At first glance, the Pen tool and paths may seem 
peripheral to Photoshop, since they are vector tools 
in an image-editing program. This lesson shows the 
value of the Pen tool as a way to make selections that 
are more precise and easier to adjust than with other 
selection tools.

Students will find that the Pen tool is the best tool to 
use for drawing the following types of selections:

• Simple shapes (except regular polygons, which are 
best drawn with the shape tools).
• Synthetic shapes with smooth, regular outlines, such
as a coffee mug
• A complex series of straight lines, like a city skyline
While all of these shapes could be drawn using other
selection tools, they will be much easier to edit and
refine if drawn as paths by the Pen tool.

This lesson will probably be quite easy for students who 
have experience with Adobe Illustrator. For them, all 
the introductory projects, which involve tracing shapes 
on the template drawings, will be primarily review.

Goals for this lesson
At the end of their session, the successful student is able
to use the Pen tool to draw both straight and curved 
paths, know how to select an deselect a path, and how 
to edit it with the path selection tools. The student also 
understands the difference between vector and raster 
artwork.

Using paths with artwork
Encourage students to learn the keyboard shortcuts for
the Pen tool and path drawing. As pointed out in
Lesson 1, keeping one hand over the keyboard for tool
switching and the other hand on the mouse can 
facilitate efficient, uninterrupted drawing. The most 
important shortcut to learn is the Ctrl (Windows) or 
Command (Mac OS) key for temporarily switching to 
the Path Selection or Direct Selection tool.

Point out that because you can freely switch a segment
between being curved and straight, there’s no need to
draw a path perfectly the first time. In fact, some 
people like to rough out a path by clicking a series of 
corner points, and then refine the path by adjusting the 
points and dragging out curves as necessary.

Converting paths to selections
After students finish this procedure, you might review
all the ways they have learned in this and earlier lessons
to create and store selections:

• As selections drawn with selection tools
• As alpha channel masks created with painting tools
• As paths drawn with the Pen tool
You could have a discussion about when students 
would want to use each technique and when it might 
be a good idea to convert a selection from one form to 
another.

Creating vector objects for the background
Point out that the shapes created with the shape tools
can be fully customized. You can even demonstrate 
how a shape can be used as a starting point for a more 
complex path, such as by drawing a rectangle and add-
ing a point to it.

Make sure students understand the difference between
the Rectangle tool and the Rectangular Marquee tool, 
so that they don’t select the wrong tool by accident.
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Supplementary demonstration: shape options
The book itself doesn’t explain much about the three
buttons (Shape Layers, Paths, and Fill Pixels) that ap-
pear on the tool options bar for the Pen tool and the 
shape tools. You could open up this topic in discus-
sions, which would definitely be of value to your 
beginning students and improve their understanding 
of Photoshop.

The crux of the difference between the Shape Layers 
and Paths options is the difference between drawing a 
shape and drawing a work path.

The key difference between the Shape Layers option 
and the Fill Pixels option revolves around the distinc-
tion between vector images and rasterized images, 
so this makes an excellent opportunity to review and 
deepen your students’ knowledge of these distinctions.
You can demonstrate this very simply. Before you be-
gin, make sure that the Foreground color is either black 
or some color other than white.

1 Create a new file (File > New) and use one of the
shape tools to draw a couple of shapes in the image:
drawing the first one with the Fill Pixels option selected
and the second with the Shape Layers option selected.
2 Zoom in but make sure that you can see at least a 
small area of each of the two shapes. Then select the 
Eraser tool.
3 Select the layer with the first shape on it and try to
erase it. Then select the layer with the second shape and
try to erase it. Discuss the results with your class.
In the first case, the eraser will remove the colored 
pixels. If you’ve zoomed in sufficiently, the bitmap 
nature of the shape will be obvious. In the second case, 
an error message appears, saying that the contents of 
the layer are not directly editable—that is, they can’t 
be erased because painting and erasing are features of 
rasterized images, not of vector drawings.
To illustrate the difference between the Shape Layers 
and Paths options, continue the demonstration, using 
the same simple drawing.
4 Drag the Paths palette out of the Layers palette group
so that students can see both palettes simultaneously.
5 In the Layer palette, select the first layer (the one with
the rasterized shape you drew).
6 Make sure that the same shape tool that you use ear-
lier is still selected, and then select the Paths option in

the tool options bar.
7 Draw the shape in the image window, making it a
different size that the earlier shapes. (Optional) You can 
reinforce the difference between the vector items and 
the bitmap shape by attempting to add an anchor point 
to each of the three shapes you drew.
8 For each of the two vector items in turn, do the
following:

• Select the layer or work path in the appropriate pal-
ette (Layers or Paths).
• Use the Direct Selection tool to select the shape.
• Using the Pen tool, click anywhere along the vector
path bounding the shape to add a point, and then drag
the point to change the shape.

9 Try to do step 8 with the third shape, the one drawn
with Fill Pixels selected, and ask your students to 
explain to you why you can’t apply this change to that 
shape. Now, your entire class should be able to see and 
accurately discuss the difference between the work 
path and the layer vector mask, as well as the difference 
between a shape and a path.

Subtracting shapes from a shape layer
Point out how each path in the Paths palette can actu-
ally contain multiple subpaths, and how any number of 
subpaths are selectable for stroking or filling.

Supplementary discussion
At this point in their learning, students sometimes start
to experience some confusion, so that similar functions
start to overlap, merge, and intermingle in their minds.
You might work with them to make sure they retain 
clear understandings of the distinctions, interac-
tions, and relationships that may exist between 
items in the following list:

• Selections
• Alpha channels
• Layer masks
• Work paths
• Vector paths
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Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 How do you deselect a path?
2 How do you make sure that a path is saved with 
a document?
3 Which tool can change corner points to curve points
and vice versa?
4 What are the advantages of using the Pen tool to cre-
ate a mask? Why not just use the Quick Mask feature, 
as done earlier in Lesson 6?
5 How do you customize the Polygon tool?
6 (Use only if you have done and discussed “Supple-
mentary demonstration: shape options,” in
this lesson’s Instructor Notes, with your class.) Why 
would the Fill Pixels option dimmed (unavailable) 
when the Pen tool is selected in the toolbox?
7 How do you save a work path?
8 When do you lose a work path forever? Is there any
recourse?

Review answers
1 Click in an empty area in the Paths palette.
2 In the Paths palette, double-click the path to name it.
3 The Convert Point tool.
4 You could select the space ship using the Quick Mask
method. But by using the Pen tool to create the mask,
you create a vector mask that retains its crisp, sharp
edges at any zoom level. In the image of the astronaut,
the contrast between the space ship and the black sky is
an abrupt change, and the ship itself has many long, 
regular lines, so it makes a good candidate for the Pen 
tool selection process.
5 Use the options in the tool options bar when a shape
tool is selected.
6 The Fill Pixels option pertains to rasterized (bitmap)
images and layers. The Pen tool is a vector tool, and 
cannot draw or edit rasterized images.
7 You can save a work path by double-clicking it in the
Paths palette and renaming it. Or, if you apply a work
path to a layer (Layer > Add Vector Mask > Current
Path), the path is saved as a layer mask and automati-
cally named.
8 You lose a work path whenever you start drawing a
new work path—that is, start drawing a new path on
another layer—without saving the original work path.
If you want to get recover a lost work path, you can try
using either the Undo command or the History palette
to go back to an earlier step.
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Lesson 10: Advanced Layering 
In Lesson 10, students learn and review advanced 
methods for adjusting a layer’s appearance, combining 
layers, and controlling the visible areas of layers. They 
also work with layer comps, introduced in Lesson 5.
Other lessons have already presented many of the con-
cepts and techniques in this lesson. For that reason, this 
chapter makes a good review of the students’ class work
so far.

Goals for this lesson
By the time students complete this lesson, they should 
be comfortable working with the Layers command and 
performing many of the more advanced functions with 
it, including creating clipping layers and merging lay-
ers. They should know how to hide and show layers, 
create layer comps, and determine whether to flatten 
their image or merge layers when they’re ready to save 
their file. 

Clipping a layer to a shape
Remind students of the fundamental rule that the 
image to be clipped (masked) must reside above the 
object that clips it.

Setting up a Vanishing Point grid
This lesson gives students additional practice in using 
the Vanishing Point filter to add three dimensions to 
their image. It’s helpful to point out to students as they 
work through these steps that precise alignment of the 
artwork is important to replicate the results in the final 
artwork. 

Placing imported artwork
You may wonder why the Place PDF dialog box ap-
pears when placing Illustrator artwork into Photoshop. 
Artwork exported from Illustrator is saved in the vector 
PDF format if the Illustrator preferences for File Han-
dling And Clipboard are set to PDF and the AICB (No 
Transparency Support). When these preferences are set, 
placing images from Adobe Illustrator into Photoshop 
displays the Place PDF dialog box. These preferences  
import or paste art as a Smart Object, rasterized image, 
path, or shape layer. When the Illustrator PDF and 

AICB (No Transparency Support) preferences are dese-
lected, the artwork is automatically rasterized. 

Filtering Smart Objects
You may want to suggest to students that they try out 
other filters and apply them to the artwork. Filters 
applied to a Smart Object are nondestructive and can 
be readjusted at any time. Lesson 11 introduces Smart 
Filters and compares their nondestructive effects to 
other filters.

Adding an adjustment layer
If you didn’t demonstrate the advantages of adjustment
layers earlier in your teaching, in Lesson 5 or Lesson 6,
you can do it here.

Working with layer comps
Consider discussing with students possible uses of layer 
comps. This lesson treats them as product prototypes. 
But they’re also useful for showing different versions 
of a design, works in progess, and editions such as in 
different languages. You can also compare this use of a 
snapshot of a state in the Layers palette to a snapshot of 
a state in the History palette.

Managing layers
Remind students of good work habits: organize their 
work into layers, groups, and layer sets so that related 
artwork stays together and it easier to update; and 
name their layers and groups so they can view the 
contents easily.

Flattening a layered image
In addition to reducing the file size, a flattened version 
is more compatible with other programs or with older 
versions of Photoshop. It’s useful to remind students 
of their options when they’ve completed work on an 
image:

Flattening an image merges all layers into a single back-
ground, greatly reducing the size of the file. Merging 
layers lets you choose which layers to flatten;
this technique combines all selected or visible layers in 
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one layer. Stamping combine the benefits of flattening 
an image while keeping some layers intact; it flattens 
two or more layers and places the flattened image into 
a new layer, while leaving other layers intact.

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 Why would you use a layer mask instead of an alpha
channel?
2 Why would you create a layer set?
3 So far, how many techniques do you know for dis-
torting images?

Review answers
1 You would use a layer mask, rather than an alpha 
channel if you wanted a sharply defined mask, or one 
that’s easy to edit.
2 Layer sets help organize documents with many layers,
make it easy to turn a specific range of layers on or off,
and easily allow a layer to affect multiple layers.
3 The distortion methods used in this and earlier 
lessons include transforming and warping text and 
objects. Each of these has its own limitations and
advantages and can be used only with specific types of
elements.
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Lesson 11: Advanced Compositing 
In this lesson, students practice colorizing parts of 
layers or entire layers, and work with filter effects. 
Students have already had some experience in earlier 
lessons with items on the upper section of the Filter 
menu: Extract and Vanishing Point. 

This lesson also presents techniques for recording 
and playing automated actions. This, of course, is not 
in itself restricted to filters or any other options or 
features.

Goals for this lesson
This lesson is more about being creative with Pho-
toshop than about strict techniques. Students have a 
chance to explore some of the more artistic applica-
tions of Photoshop as they composite four images.

About gaining mastery of filters
The range of possibilities for using filters goes beyond
the scope of this book and even beyond the imagina-
tion of any one user because the possibilities are virtu-
ally unlimited. Students who are serious about using
Photoshop to create special effects will quickly discover
two things:

• That any time they invest in reading about Photoshop
filters in Help is time well-spent.
• That there is no substitute for just spending time
playing around with the filters, experimenting with
various combinations and settings to see what they’ll 
do in different images and on various layers.

Be sure that your students understand that Photoshop
online Help has a great deal of valuable information
about filters, almost none of which is included in the
printed Adobe Photoshop CS3 User Guide.

Applying Smart Filters
When introducing students to Smart Filters, you can 
compare them both to Smart Objects and adjustment 
layers. As with both, Smart Filters are nondestructive: 
they can be adjusted, turned off and on, and deleted, at 
anytime. In contrast, regular filters permanently change 

an image; one applied, they cannot be removed. Unlike 
adjustment layers, however, Smart Filters can be ap-
plied only to a Smart Object layer, so the layer itself can 
no longer be edited—just its Smart Filter effects. You 
may want to suggest to students that they duplicate and 
hide layers that they want to keep and continue to edit, 
before applying a Smart Filter to the layer.

Saving selections
Remind students to save selections whenever
there is a chance that a difficult or time-consuming
selection might need to be reused.

Creating a layer and choosing a blending mode
You can suggest a keyboard shortcut that students can
use when they create a new layer: Press Alt (Windows) 
orOption (Mac OS) while clicking the New Layer but-
ton to open a New Layer dialog box. Then draw your 
students’ attention to the options available in this dia-
log box, including not only a Name option, but options 
for grouping the layer, designating a color code (not a 
fill color, as some students assume), assigning a blend-
ing mode, and setting opacity.

Applying painting effects
Students can compare the colorized version to the 
original desaturated version by turning the Paint layer 
off and on.

Changing the color balance
Again, students can get a before and after view by turn-
ing the adjustment layer off and on. 

Extra Credit 
Borders are best kept on a layer separate from the main
image, as in this procedure, so that they can be turned
off if necessary.

Supplementing this lesson
Encourage your students to experiment with the differ-
ent filters on their own. You could say that the real fun
of complex images builds on a foundation of multiple
layers that include multiple filter effects, multiple 
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opacity settings, and multiple blending modes.
At the same time, make sure that your students are 
aware of the following issues about the filters (also 
listed in online Help, under “Using filters”):

• The last filter chosen appears at the top of the Filter
menu.
• Filters are applied to the active, visible layer or to a
selected area on that layer.
• The image mode (the command selected on the
Image > Mode menu) can be an important issue for 
two reasons: Filters cannot apply to Bitmap-mode or
indexed-color images, and some filters work only on
images in RGB mode.
• Some filters are processed entirely in RAM.

Again, remind students that while the printed 
Adobe Photoshop CS3 User Guide devotes very little ink 
to the subject of filters,  Photoshop Help contains a 
wealth of information.

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 Which blending mode changes the hue of a layer
without affecting the tone?
2 How can you quickly colorize an entire layer without
making any selections?
3 Where would you start looking for more information
about filters?
4 What are some of the differences between filters and
blending modes.

Review answers
1 The Color mode.
2 Just add a Hue/Saturation adjustment layer and click
its Colorize option.
3 Photoshop Help includes many pages of information
about filters that are not found in the printed User
Guide.
4 Typically, blending modes apply either at the layer
level or to painting tool properties. You can apply filters
to layers or to selected areas of an image layer.
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Lesson 12: Preparing Files for the Web
Up to this point, most of the lessons in this book have
been geared toward print output. This lesson is the first
oriented specifically toward web work. 

Lesson 12 introduces slices, rollovers, and GIF anima-
tion, as well as optimizing files for the web. With slices, 
students learn how to define and linkisolated areas of 
a graphic rather than having the entire image as a hot-
spot for just one URL. Students also learn how to add 
rollovers to slices, and add interactive visuals as well as 
links to other web pages. It’s a good idea to finalize a 
design before creating rollovers for it. 

Animating an image can be as simple as moving a layer 
across the screen or changing layer attributes, and the 
process of optimizing an animation for the web isn’t 
much different than optimizing a still image. In other 
words, it’s not difficult to transform an image from a 
static graphic to an eyecatching animation.

Photoshop CS3 has limited web design functions, with 
the elimination of  ImageReady in this product release. 
With the merger of Adobe and Macromedia—as well 
as the integration of their product lines and print and 
web software—users are encouraged to design in 
Photoshop and then use Adobe Dreamweaver CS3 to 
add HTML coding, interactivity, and web functionality 
to their designs.

Scheduling this lesson
Three independent subprojects comprise the lesson. 
You can schedule all three for one session or break 
them up into different sessions. The chief focus
of the lesson is on setting up slices using Smart Guides, 
adding animation and interactivity, and optimizing the 
file. None of the concepts or techniques is difficult. 

Getting started
Students may miss seeing the logo animate in the up-
per left corner when they open their web browser (it 
animates only once). If they miss the action, instruct 
them to use their browser controls to refresh or reload 
the page. 

Setting up a Web Design workspace
Encourage students to explore the other workspaces 
supplied with Photoshop CS3. 

Creating slices
Students should be aware that slicing an image does 
not make it download faster. In reality, a sliced image 
takes more time to download because each additional 
piece of a web page requires additional overhead for 
transmission over the network. Images should be sliced 
only when necessary for interactivity.

Make sure that students understand what slices are not:
selections, shapes, or masks. You might discuss the dif-
ferences between slices and these other items.

Creating slices based on layers 
If the design of a web page is not final, layer-based 
slices may be the best to use, because they will auto-
matically resize to match the layer on which they are 
based. If editing a layer changes its size, you won’t have 
to re-do its slice to match.

Creating navigation buttons
This is a good place to have students check out the Slice 
Options dialog box. Have them select another slice, and 
in the Slice Options dialog box, leave its Type as Image. 
Point out the Name, URL, and Target options, and ex-
plain how filling in these options here means that they 
don’t have to do it when coding the HTML, especially 
if the graphics are edited and exported to HTML again.

Creating an animated GIF
From this procedure, students should understand how
valuable it is to plan and execute a Photoshop design
using layers if animation is an intended use for the
graphic.When a graphic represents the end of the 
animation, it’s much easier to start at the end of the 
animation with the final graphic and work backwards 
to the beginning, than it is to start at the beginning and 
try to precisely animate all the elements into their final 
positions.
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Tweening the position and opacity of layers
Tweening is another important animation strategy that
students should internalize. They should plan their ani-
mations in terms of the points at which major changes
happen, animate to those points, and tween between
those points to fill in the rest. Using tweening in this 
way will be much easier than trying to animate every 
single frame by hand.

The lesson tells the user to choose the Tween command 
on the Animation palette menu. Students will probably 
appreciate your pointing out to them that the Tween 
button on the Animation palette is the easier way to 
open that dialog box. 

At the end of the lesson, you might ask the students to
guess why we included four different animations in the
lesson. With any luck, they’ll pick up on the essential 
differences between the four projects: animating only 
on layer visibility, animating based on layer postion 
and layer styles, and animating with two types of 
masks: layer masks and vector masks.

Exporting HTML and images
Some students may complain that they don’t see much
difference between the “before” and “after” versions of
the various thumbnail images they see in the Save For 
Web And Devices dialog box.If so, treat that as a good 
thing. The key information—the file size, and therefore 
the download time—is not apparent by looking at the 
images. For that, they have to compare the metadata 
for each of the images.

Before completing work in the Save For Web And De-
vices dialog box, you may want to point out the button 
in the top right of the preview area. Clicking this but-
ton reveals a palette menu that changes the display of 
the selected preview area to simulate different display 
conditions.

This menu is also available by right-clicking (Windows) 
or Control-clicking (Mac OS) any of the preview panes. 
Also notice the Device Central button at the bottom right 
of the dialog box. This button allows emulating artwork 
(that doesn’t contain slices) for display by various models 
of mobile devices, such as cell phones and PDAs. 

Adding interactivity
Zoomify, new in Photoshop CS3, is useful for publish-
ing high-resolution, large format images to the web. 
For additional practice with this feature, you may want 
to suggest that students use images from the Lesson13/
Maps folder.  

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 How do you select a slice?
2  Describe five types of slices.
3  Why would you want to use a No Image slice?
4 What role do layers play in animating an image?
5 How do you control the delay between frames?
6 How can you make an animation appear smoother?
7 How do you decide whether to use GIF or JPEG for 
a Web graphic?

Review answers
1 Use the Slice Select tool to select the slices. The
Optomize Palette affect selected slices only.
2 Five types of slices exist:
• User slices are created manually with the Slice tool.
• Layer-based slices are created using the Layer > New
Layer Based Slice Command.
• Auto slices are automatically generated to fill in the
gaps between the slices you create.
• Subslices are a type of auto-slice generated when
other slices overlap.
• No Image slices do not generate an image, but can
contain a background color or text.
3 A No Image slice is useful for an empty area of a web
page. Because it doesn’t generate an image, it can 
reduce a page’s download time.
4 Layers serve as reference points for frames and for
important transitional events in an animation, such as
tweening.
5 In the Animation palette, click the Frame Delay menu
under a frame.
6 Use tweening to create additional frames.
7 Use GIF for flat-color graphics or graphics that only
use a few colors, such as a company logo. Use JPEG for
continuous-tone images that have subtle transitions or
use many colors, such as full-color photographs.
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Lesson 13: Working with Scientific Images
Lesson 13 covers enhanced functions in Adobe Bridge 
as well as features of Photoshop CS3 Extended. It’s pos-
sible that not all classrooms will include this version of 
Photoshop CS3. However, students can partially com-
plete the lesson, up to “Measuring objects and data,” 
and then read through the rest.  

This lesson also includes some nice design techniques 
that can translate to many applications—including 
highlighting an inset selection within an image and 
creating dashed lines and custom borders.

Whether students have this Photoshop CS3 Extended 
version or not, it’s a good idea to briefly introduce 
them to its capabilities—all the features in the standard 
edition of Photoshop, plus functions for specialized 
markets, including technical image analysis, film and 
video work, and three-dimensional design. This lesson 
shows how to use Photoshop Extended measurement 
and data analysis tools.

Before beginning the lesson, have students watch the 
QuickTime movies on Adobe Bridge and Measurement, 
located in the Adobe Photoshop CS3 Classroom in a Book 
CD Movies folder. To play the movies, double-click the 
movie file to open it; then click the Play button.

The students won’t change the appearance of the origi-
nal sample files, other than to label them. But they will 
rename them and add some metadata and keywords to 
the remaining files.

Adobe Bridge is especially useful to students who work 
with digital cameras. Bridge takes the sting out of sorting 
through large numbers of unnamed photographs that 
do not have descriptive file names, looking for the image 
you want. For background on good work practices, 
refer students to the sidebar in Lesson 7, “Pro Photo 
Workflow.” 

Goals of this lesson
At the conclusion of this lesson, your students should
know how to use Adobe Bridge to find an image they

want to open in Photoshop. They should also be famil-
iar with the other Bridge functions: renaming files,
ranking files, rotating images, and previewing images
and data associated with those files. They should 
understand how to use the Measurement feature to 
measure objects and record data, and compare and 
analyze the information.

Viewing and editing files in Adobe Bridge 
You should make sure your students understand that
they do not have to use Bridge to open a file.
If your students are not beginning computer users, they
will already be familiar with the standard methods of
selecting multiple items. Make sure they understand 
the meaning of the word contiguous.

Using Bridge to organize and search your elements
This procedure introduces the process of doing some-
thing in batches—that is, applying a change in an auto-
mated way to multiple items. You might emphasize that
this is more than merely making the same change to
multiple items. If they haven’t already completed Les-
son 11, mention that they can learn how to create their 
own automated actions in that lesson.

Creating a map border and work area
Point out to students that this technique for highlight-
ing an inset (or an inverse selection) is useful
for other designs. 

Making a custom border
Students can apply this technique of creating a dashed 
line—as well as creating a custom border—to other 
design work.

Measuring objects and data
Discuss with students the difference between the Ruler 
tool and the Measurement tool.

In Photoshop CS3 Extended, the souped up counter-
part of the Ruler tool is the Measurement tool. This 
tool lets you compute various measurements and 
record them in the Measurement Log palette. 
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The Ruler tool in Photoshop calculates the distance 
between any two points in the workspace. The 
Measurement feature in Photoshop Extended mea-
sures any area defined with the Ruler tool or with a 
selection tool, including irregular areas selected with 
the lasso, quick select, or magic wand tools. 

The Measurement feature can also compute the height, 
width, area, and perimeter; or track measurements of 
one image or multiple images. Measurement data is 
recorded in the Measurement Log palette, where it can 
be sorted or exported to a spreadsheet file (Windows 
only). 

Emphasize to students the importance of beginning 
with a control measurement, against which they can 
verify the accuracy of other measurements.

Measuring irregular shapes
It may be useful to ask with how they would approach 
measurement of different shaped areas and objects. 
Discuss with students strategies for measuring irregular 
shapes that can’t be measured neatly between Point A 
and B.  

Exporting measurements
This Windows only feature allows exporting selected 
measurements as a CSV (comma separated value) file 
that can be opened in a spreadsheet application, such 
as Microsoft® Excel.  Once the file is exported, it can be 
used in the spreadsheet application to perform further 
calculations on the data. 

Measuring in perspective with 
the Vanishing Point filter
For accurate measurement when using the Vanishing 
Point filter, students need to position the pointer over 
the grid. A red border indicates a measurement was 
made outside of the grid; results won’t be accurate. If 
a red border appears after students completed Step 5, 
have them redo the measurement starting from Step 3.
 

Creating a slide show
You might want to compare this technique with that of 
creating a PDF portfolio at the end of Lesson 7. 

Review questions
The following questions are not in the student’s 
Classroom in a Book.

1 How do you add notes to a document or delete them?
2 How does rotating an image file in Adobe Bridge
affect the image itself?

Review answers
1 To add notes or audio annotations anywhere on a 
Photoshop image canvas, select the Notes or Audio An-
notations tool in the toolbox, and then click. When you 
create a note, a resizable window appears for typing 
text. When you record an audio annotation, you must 
have a microphone plugged into the audio_in port 
of your computer. You can also import both kinds of 
annotations from Photoshop documents saved in PDF 
or from Acrobat documents saved in PDF or Form 
Data Format (FDF). To delete the annotations in your 
document, select either the Notes or the Audio Anno-
tation tool and click Clear All in the tool options bar. 
All notes and audio annotations are deleted from your 
document.
2 Two things happen when you rotate an image file in
the Adobe Bridge. First, the thumbnail and preview 
image of the file appear rotated in the Bridge. This 
represents how the file will appear when you open it in 
Photoshop.If you open it in another program or place 
it in a layout without either applying the rotation with 
the Apply Rotation command or opening the rotated 
filea nd saving it in Photoshop, it will not be rotated at 
this point.
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Lesson 14: Producing and 
Printing Consistent Color
Lesson 14 walks students through a basic color 
workflow, including printing a proof and printing 
separations. Commercial printers have widely varing 
requirements for color management, and many still 
prefer to work in a more traditional workflow that 
avoids color management. Students should understand 
the importance of discussing color with the printer to 
understand how their particular printer prefers to 
receive a color job. It’s important that students under-
stand the difference between color correction and color 
management. Color correction fixes bad-looking color. 
Color management can’t do that. The purpose of color 
management is to create an accurate viewing environ-
ment so that you can precisely determine which colors 
are right and wrong. 

Reproducing colors 
Because the RGB gamut is much larger than the 
CMYK gamut, some people assume that all CMYK col-
ors fit within RGB. However, this is not true, because 
the gam-uts are different shapes that do not overlap 
perfectly. You may want to have students examine the 
color gamut fig-ure on page 451 and point out the 
small areas of CMYK that are outside the RGB gamut. 
Those CMYK colors cannot be reproduced on an RGB 
monitor. 

Specifying color management settings 
The Color Settings dialog box can be intimidating, 
espe-cially for beginners. You might mention that the 
Color Settings dialog box is convenient because you set 
it once and don’t worry about it again unless there is a 
major change in your workflow. 

Proofing an image 
The Missing Profile and Embedded Profile Mismatch 
dialog boxes can be very confusing. Your class may find 
it helpful to understand that the warnings fall into two 
basic categories: 

• Leave the document as it is. This means choosing 
either to use the embedded profile (if it exists) or leav-
ing the document without a profile (if it doesn’t exist). 
• Adjust the document. If the document is missing a 
profile, then you can choose to assign one—either the 
current working space or a different profile. If you’re 
opening a document with a mismatched profile, you 
can choose to discard the profile, or convert the colors 
to the current working space. 

When a profile mismatch occurs, you can also opt to 
“Discard the embedded color profile (don’t color 
manage).” That means that Photoshop will neither 
change the image’s color values nor will it embed a 
profile that records the current viewing environment. 
This means the image may not look right on screen 
even if its colors are actually correct. If a commercial printer 
does not use color management, they may actually 
recommend this choice so that values in a CMYK image 
will not be changed. This is valuable if a CMYK image 
is already tuned for the press—any changes would 
mess it up. The two most likely rendering intents to 
use for photo-graphic images are Relative Colorimetric 
and Percep-tual. The more an image contains colors 
that are outside the destination gamut, the more likely 
Perceptual might be a good idea. The Preview option 
in the Customize Proof Condition dialog box is useful 
when deciding which one to use. 

The appearance of an RGB image after converting to a 
CMYK gamut is often disappointing. Overall saturation 
is usually lower and some colors may shift. Reassure 
students that Photoshop is simply being honest about 
what colors can actually be achieved in the CMYK 
gamut at SWOP settings (assuming that all Color 
Settings are set correctly). 

It can be useful to do this exercise with two views open. 
You can have students choose Window > Arrange > 
New Window for 16Start.tif to open a second window 
for the image. Leave the first window as is, and use the 
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second window for Proof Setup. This way, a 
before/after com-parison is possible. 

Identifying out-of-gamut colors 
It’s best to choose a color that is clearly out of gamut 
so that it can’t be confused with any real colors in the 
image. A good way to do this is to specify a bright color 
at maximum saturation. 

You might mention exactly how Photoshop does 
the RGB-to-CMYK conversion. It will start from the 
image’s RGB working space and convert to the current 
CMYK working space. This means that the quality of 
the con-version depends on proper settings and good 
profiles. 

Adjusting an image and printing a proof 
If these steps are done with Proof Setup on, the image 
can be corrected in the context of the CMYK output 
gamut. 

Saving the image as a separation 
Instead of switching back and forth between RGB 
and CMYK, students may prefer to see the two views 
simultaneously. 

Printing halftone separations 
Students should understand that in practical terms, 
that this procedure only works if you’re printing directly 
from Photoshop, not if you’re going to move the image 
into another program. 

Review questions 
The following questions are not in the student’s 
Classroom in a Book. 
1 What is a working space? 
2 Why is it important to choose the proper working 
spaces in Color Settings? 
3 How can you preview how an image will appear in 
final output? 
4 How can you identify out-of-gamut colors? 

Review answers 
1 A working space is the color gamut within which 
Photoshop will adjust an image’s colors. 
2 The working spaces should be appropriate for the 
final output you are targeting. 
3 Create a custom Proof Setup that uses a profile and 
settings that represent the final output, then make sure 
View > Proof Colors is on and set to that setup. 
4 Turn on View > Gamut Warning. 
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